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Vorwort 

Die Universitätsbibliothek Heidelberg bietet seit vielen Jahren Kurse zu Literaturverwal-

tungsprogrammen an. Diese Programme ergänzen das elektronische Informationsangebot 

der Bibliotheken in geeigneter Weise. Sie bieten vielfältige Möglichkeiten, in Datenbanken 

und anderen elektronischen Quellen recherchierte Informationen bzw. bibliographische Da-

ten in eine persönliche Datenbank zu importieren, mit eigenen Informationen zu ergänzen 

und in wissenschaftlichen Textdokumenten zu zitieren. Damit wird die Erstellung von Haus- 

und Abschlussarbeiten, aber auch die Publikation von Forschungsergebnissen beträchtlich 

erleichtert. 

Besonders leistungsfähige Literaturverwaltungsprogramme bieten neben Recherche-

schnittstellen zu Informationssystemen umfangreiche Sammlungen von Zitierstilen an, die 

für die Erstellung von wissenschaftlichen Texten genutzt werden können. 

Die Universität Heidelberg, vertreten durch die Universitätsbibliothek, hat sich u.a. für 

EndNote entschieden, da dieses langjährig etablierte und weit verbreitete Literaturverwal-

tungsprogramm komfortable Anbindungen an Datenbanken und Textverarbeitungspro-

gramme sowie mehrere tausend Zitierstile anbietet, die zusätzlich an individuelle Bedürf-

nisse angepasst werden können. Mitglieder der Universität Heidelberg können das Pro-

gramm auf Basis der Campus-Lizenz kostenlos nutzen. Die Installation von EndNote erfolgt 

über den Downloadbereich auf den entsprechenden Seiten der Universitätsbibliothek. End-

Note steht sowohl für Windows- wie für Mac-Systeme zur Verfügung. 

Die Universitätsbibliothek Heidelberg unterstützt die Nutzung von EndNote mit Einfüh-

rungskursen. Die Termine für die einzelnen Veranstaltungen sind auf den Schulungsseiten 

der Universitätsbibliothek zu finden. 

Dieses Skript basiert auf der Version EndNote 20. Es ist als kursbegleitendes Material 

für den EndNote-Einführungskurs konzipiert und orientiert sich an dessen Inhalten. Die 

Funktionen und Screenshots von EndNote werden in diesem Skript auf Basis der Windows-

Version dargestellt, seit Version 20 finden sich annähernd alle Funktionen der Mac-Version 

unter den gleichen Hauptmenüpunkten. 

Neben diesem Skript finden Sie auf den Schulungsseiten der Universitätsbibliothek 

zahlreiche Materialien zur Nutzung von EndNote sowie offizielle Zitierstile von Instituten 

bzw. Fakultäten der Universität Heidelberg zum Download in Ihre EndNote-Bibliothek. 

Bei Fragen und Anregungen wenden Sie sich bitte per Mail an das Schulungsteam: schu-

lung@ub.uni-heidelberg.de. 

Die vorliegende 2. Auflage wurde auf der Grundlage der von Martina Trognitz, Benno 

Homann, Christiane Hirschberg und Nicole Kloth erstellten Anleitung, zuletzt aktualisiert 

2015, erarbeitet. Wegen der Neuerungen von EndNote 20 wurde die Anleitung grundlegend 

überarbeitet. 

 

 

Hinweis:  Das Programm hat eine englischsprachige Oberfläche, daher werden in 

dieser deutschsprachigen Anleitung die englischen Begriffe belassen. 

 

 

  

https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/download.html
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/Welcome.html
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/Welcome.html
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/Welcome.html
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/zitierstile/Welcome.html
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/zitierstile/Welcome.html
mailto:schulung@ub.uni-heidelberg.de
mailto:schulung@ub.uni-heidelberg.de
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1 Download und Installation, Systemvoraussetzungen und Updates 

Auf den Internetseiten der Universitätsbibliothek Heidelberg zum Thema Literaturverwal-

tung finden Sie den Link zum Download der EndNote-Installationsdateien für Windows- und 

Mac-Nutzer. Bitte beachten Sie die Installationshinweise. 

EndNote für Windows: 

 Hinweis: für die folgenden Arbeitsschritte benötigen Sie ein ZIP-Programm, z. B. 

das kostenlose 7-Zip. Entpacken/Entzippen Sie zuerst die Datei durch Doppelklick 

auf Install-Endnote20-Windows.zip in einen neuen Dateiordner. Wählen Sie die Op-

tion Alle extrahieren aus. 

 Wechseln Sie in den Dateiordner mit den nun entzippten Dateien. Klicken Sie auf 

die Datei EN20Inst.msi. Die erforderlichen Lizenzdaten werden aus der Datei li-

cense.dat automatisch ausgelesen. Dafür muss sich diese Datei im selben Ver-

zeichnis wie die Datei EN20Inst.msi befinden. 

 Führen Sie die angegebenen Installationsschritte aus. 

 

 

Hinweis:  Wenn die Installation nicht funktioniert, dann haben Sie wahrscheinlich 

den Schritt Entpacken/Entzippen übersehen! 

 

EndNote für Mac: 

 Laden Sie die Datei EndNote20SiteInstaller.dmg auf Ihren Mac. 

 Starten Sie die Installation durch einen Klick auf die Datei. 

 

Systemvoraussetzungen 

Informationen zu den Systemvoraussetzungen finden Sie auf den Seiten des Anbieters. 

 

Programm-Updates 

Sollten Sie das Programm bereits installiert haben, können Sie überprüfen, ob Sie auf dem 

neuesten Stand sind, indem Sie auf Help > Check for Updates klicken. Stehen dort Updates 

zur Verfügung, empfiehlt es sich, diese zu installieren. 

 
 

2 EndNote-Bibliotheken und die Programmoberfläche 

2.1  Erste Schritte mit der Sample Library 20 

Um sich mit dem Programm und der Programmoberfläche vertraut zu machen, können Sie 

die Beispieldatenbank Sample_Library_20 nutzen, die Sie im EndNote-Programmordner 

neben anderen Übungsdateien im Unterordner Examples (bei Windows-Rechnern unter 

C:\Programme(x86)\EndNote20\Examples) finden. 

Öffnen Sie die Datei Sample_Library_20 mit einem Doppelklick. 

 

 

 

 

 

https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/download.html
https://endnote.com/product-details/compatibility
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2.2 Die Programmoberfläche von EndNote 

 

 

 

 

 

 
 
 
 
 

 Über die Menüleiste können Sie alle Funktionen aufrufen. 

 Über die Icons in der Symbolleiste lassen sich häufig benötigte Funktionen schnell auf-

rufen. 

 Im Groups Panel werden permanente (Standardgruppen), selbsterstellte (Custom 

Groups) und temporäre Gruppen angezeigt. 

 

Zu den permanenten Gruppen, die immer angezeigt werden, gehören: 

o All References: Anzeige aller Referenzen Ihrer EndNote-Bibliothek. 

o Recently Added: Anzeige von Neuzugängen in Ihrer EndNote-Bibliothek standard-

mäßig für 24 Stunden. Mit Rechtsklick auf den Gruppennamen kann das Kontext-

menü aufgerufen und der Zeitraum für die gerade genutzte Bibliothek auf max. 30 

Tage erhöht werden. 

o Unfiled: Anzeige von Referenzen, die keiner Custom Group zugeordnet wurden. 

o Trash: Nicht mehr benötigte Referenzen können mit Drag & Drop in den Papierkorb 

verschoben werden. Sie bleiben dort so lange erhalten, bis Sie den Papierkorb lee-

ren (Kontextmenü mit rechter Maustaste aufrufen und Empty Trash auswählen). 

 

 In der Reference List werden alle Referenzen einer EndNote-Bibliothek aufgelistet (falls 

im Groups Panel All References ausgewählt ist). Jede Referenz wird auf einer Zeile 

dargestellt. Die bibliographischen Angaben sind spaltenweise angeordnet. Durch Klick 

auf die Spaltenüberschrift kann man die Referenzen auf- und absteigend sortieren (Bei-

spiel: absteigend nach Erscheinungsjahren ordnen, sodass die aktuellste Literatur im-

mer an erster Stelle angezeigt wird). Mit Klick auf die Spaltenüberschrift bei gedrückter 

Maustaste lassen sich die Spalten verschieben. 

Groups Panel 

Erweiterte Suche Summary- und Edit-Tabs 

Symbolleiste 

Menüleiste 

Reference List mit Listenansicht 

der Referenzen 

Preview mit Zitierstilauswahl 
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In der Standardeinstellung werden folgende Angaben angezeigt: 

o Erste Spalte: Über die Checkbox können Referenzen als gelesen oder ungelesen 

markiert werden. 

o Zweite Spalte: Eine Büroklammer zeigt an, dass eine Datei mit der Referenz ver-

knüpft ist. 

o Author: Autoren der Publikation 

o Year: Erscheinungsjahr der Publikation 

o Title: Titel der Publikation 

o Rating: Bewertung der Referenz 

o Journal: Titel der Zeitschrift 

o Reference Type: Referenztyp (= Dokumenttyp) 

o Last Updated: Datum der letzten Änderung der Referenz 

o Record Number: Nummer des Datensatzes in der Datenbank 

 Im Summary / Edit-Tab lassen sich über die Tabs zwei verschiedene Ansichten aufru-

fen: 

o Summary: In dem zweigeteilten Fenster wird die Referenz im oberen Bereich mit 

allen wichtigen bibliographischen Informationen inklusive Abstract (sofern vorhan-

den) angezeigt. Am oberen Rand werden mit der Referenz verknüpfte Dateien an-

gezeigt, die über die Schaltfläche mit dem Dateinamen aufgerufen werden können. 

Über die Schaltfläche +Attach File können Dateien mit der Referenz verknüpft wer-

den. 

o Preview: Die Preview-Ansicht unter der Summary-Ansicht ermöglicht eine Vorschau 

auf die Referenz im ausgewählten Zitierstil und zeigt die Referenz so an, wie sie in 

der Literaturliste eines Dokumentes aussehen würde. Den Zitierstil können Sie über 

das Dropdown-Menü zur Auswahl der Zitierstile über dieser Anzeige einstellen. 

o Edit: Anzeige der Referenz als Datensatz mit allen bibliographischen Informationen, 

die hier ergänzt und bearbeitet werden können. 

 

2.3  Eine eigene EndNote-Bibliothek anlegen 

Über File > New erstellen Sie eine eigene EndNote-Bibliothek. Vergeben Sie einen Namen 

und legen Sie den Speicherort fest. 

Ihre EndNote-Bibliothek besteht aus einer Datei mit der Endung .enl und einem DATA-

Ordner mit dem gleichen Namen: 

 

 
 

Der DATA-Ordner enthält u.a. angehängte PDF-Dateien, die Gruppen und Term Lists (s. 

dazu auch Kap. 3.2). Wenn Sie eine Kopie Ihrer Bibliothek z.B. mit Copy & Paste sichern 

möchten, müssen Sie die Datei und den Ordner kopieren, damit Ihre Bibliothek weiterhin 

funktioniert und Sie keine Datenverluste erleiden. 

Wenn Sie eine EndNote-Bibliothek schließen (über das „X“ rechts oben oder über File 

> Close Library), werden alle Änderungen automatisch gespeichert. 
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Hinweis:  Speichern Sie Ihre EndNote-Bibliothek auf dem eigenen Rechner und 

nicht in einer Cloud wie z.B. Dropbox oder einem lokal synchronisierten 

Laufwerk über OneDrive oder iCloud. EndNote speichert Änderungen an 

der EndNote-Bibliothek in einer bestimmten Reihenfolge. Bei gleichzeiti-

ger Synchronisierung einer Datei durch einen Clouddienst kann EndNote 

nicht speichern. Auf Dauer kann dies zu einer Beschädigung bis hin zur 

Unbrauchbarkeit Ihrer EndNote-Bibliothek führen.1 

 

Wenn Sie diese Speicherorte für Sicherheitskopien Ihrer EndNote-Bibli-

othek verwenden, laden Sie die EndNote-Bibliothek vor dem Öffnen und 

Bearbeiten auf Ihren Desktop herunter. 

 

 

Tipp:  Über Edit > Preferences > Libraries können Sie festlegen, wie EndNote 

künftig starten soll. U.a. können Sie die Option wählen, dass beim Start 

von EndNote eine bestimmte Bibliothek, z.B. Ihre eigene automatisch 

geöffnet wird. 

 

 
 

 

3 Aufnahme und Import von Referenzen in eine EndNote-Bibliothek 

Referenzen können auf unterschiedliche Arten in eine EndNote-Datenbank aufgenommen 

werden: 

 Manuelle Erfassung 

 Export aus Katalogen, Datenbanken, wissenschaftlichen Suchmaschinen, Fachpor-

talen oder elektronischen Fachzeitschriften nach EndNote 

 Über Online Search aus EndNote heraus 

 Import aus PDF-Dateien mit DOI-Nummern. 

3.1  Manuelle Erfassung von Referenzen 

Über References > New Reference oder das Icon mit dem Plus in der Symbolleiste können 

Sie ein leeres Fenster zur Erfassung einer Referenz aufrufen: 

 

                                                           

1  Alfasoft. "EndNote, iCloud, Sync und Speicherorte". 

https://support.alfasoft.com/hc/de/articles/360000976437-EndNote-iCloud-Sync-und-Speicherorte
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Wählen Sie zuerst den passenden Referenztyp für das zu erfassende Dokument über das 

Dropdown-Menü Reference Type aus. Abhängig vom Referenztyp ändern sich die Felder 

eines Datensatzes. Voreingestellt ist der Referenztyp Journal Article. Weitere häufig benö-

tigte Referenztypen sind: 

 Book (Monographie) 

 Book Section (Artikel in einem Sammelband) 

 Edited Book (Sammelband, Aufsatzsammlung) 

 Webpage (Webseite). 

Eine Liste aller Referenztypen mit deutscher Übersetzung finden Sie im Anhang dieses 

Skripts und auf der entsprechenden UB-Seite. 

Wenn Sie elektronische Bücher und Aufsätze zitieren, verwenden Sie die oben aufge-

führten Referenztypen und zitieren Sie nach Möglichkeit einen permanenten Link (DOI oder 

URN), alternativ die URL. Daraus geht hervor, dass Sie die elektronische Version einer 

Publikation und nicht die Printausgabe zitieren. 

Tragen Sie Ihre Angaben in die einzelnen Felder ein. Mit dem Cursor oder der Tab-

Taste können Sie die Felder ansteuern. Wenn Sie fertig sind, klicken Sie rechts oben auf 

die Schaltfläche Save. 

 

3.2 Regeln zur manuellen Erfassung von bibliographischen Daten 

 Geben Sie alle Angaben unformatiert ein. Formatierungen wie Fett, Kursiv etc. werden 

über den Zitierstil bei der Erstellung einer Bibliographie automatisch zugefügt. 

 Wenn Sie in den Feldern Author, Journal und Keywords Begriffe wie Namen oder 

Schlagwörter zum ersten Mal eintippen, werden diese in roter Schrift angezeigt und in 

die Term Lists der Felder aufgenommen. Werden Begriffe erneut eingetragen, macht 

EndNote über die Auto-Complete-Funktion Vorschläge mit ähnlichen Namen, die Sie 

mit Enter übernehmen können. Das erleichtert die Schreibarbeit und sorgt dafür, dass 

Begriffe in der gleichen Schreibweise in die Datenbank aufgenommen werden. Im Fall 

von Autorennamen findet man so bei einer späteren Suche alle Publikationen eines 

Autors unter der gleichen Namensform. Die Auto-Complete-Funktion ist voreingestellt. 

Sie kann über Edit > Preferences > Term Lists > Suggest terms as you type ab- bzw. 

wieder eingeschaltet werden. 

Referenztyp auswählen 

Speichern 

Sie können per Maus durch den 

Datensatz scrollen, sich mit der 

Tabulatortaste vorwärts (und mit 

Shift + Tabulatortaste rückwärts) 

bewegen oder die Felder mit dem 

Cursor direkt ansteuern. 

https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/materialien/EndNote-Referenztypen.pdf
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3.2.1 Autorennamen 

 Erfassen Sie jeden Namen in einer eigenen Zeile. 

 Erfassen Sie Autorennamen in der Form Nachname, Vorname(n). Eine Erfassung in 

der Form Vorname Nachname kann besonders bei mehrteiligen Namen zu Fehlinter-

pretationen führen. 

 Erfassen Sie Vornamen möglichst vollständig. Über eine Zitierstil-Änderung können Sie 

jederzeit regeln, dass Vornamen bei der Ausgabe im Dokument abgekürzt angezeigt 

werden. 

 Sind Ihnen die vollständigen Vornamen nicht bekannt, geben Sie die abgekürzten Vor-

namen als „A.B.“, „A. B.“ oder „A B“ ein. Einen Eintrag in der Form „AB“ interpretiert 

EndNote als einen Vornamen. 

 Lassen Sie Angaben wie Funktionsbezeichnungen (Hrsg., hrsg. von, Übers.) weg. Sie 

werden automatisch über den Zitierstil ergänzt. 

 Namenspräfixe wie z.B. „von“, „van“ oder „de“ werden vor den Nachnamen eingegeben, 

z.B. „de Gaulle, Charles“. 

 

3.2.2  Organisationen als Urheber 

Die korrekte Wiedergabe der Namen von Organisationen wird über Kommata gesteuert: 

 Geben Sie den Namen ein und setzen Sie am Ende ein Komma: „Universität Hei-

delberg,“ 

 Kommt im Namen ein Komma vor, das erhalten bleiben soll, setzen Sie zwei Kom-

mata: „Ruprecht-Karls Universität ,,Heidelberg“. 

 

3.2.3  Titel 

 Erfassen Sie Haupttitel und Zusatztitel im Feld Title fortlaufend und klicken Sie am 

Zeilenende nicht auf Enter. Der dadurch ausgelöste Zeilenumbruch wäre auch im 

Literaturverzeichnis Ihres Dokuments zu sehen. 

 

3.2.4  Seitenzahlen 

 Schreiben Sie bei Aufsätzen aus Zeitschriften und Sammelbänden nur die Seiten-

zahlen in das Feld Pages. Die Form der Ausgabe, zum Beispiel mit automatisch 

vorangestelltem „S.“, wird über den Zitierstil geregelt. 

 

3.2.5  Verlagsort und Verlag 

 Verlagsorte werden im Feld Place Published, Verlage im Feld Publisher erfasst. 

Schreiben Sie die Angaben in eine Zeile und beachten Sie dabei Ihre Zitierregeln. 

 

3.2.6  Auflage 

 Erfassen Sie im Feld Edition nur die Zahl der Auflage. Die Darstellung, z.B. mit 

nachgestelltem „Aufl.“, wird über den Zitierstil geregelt. 

 

 

4 Übernahme von Daten aus Datenbanken und Online-Recherche 

Mit EndNote können Sie zum einen über die Online Search aus EndNote heraus in Daten-

banken recherchieren und die Ergebnisse übernehmen. Dies funktioniert aber nur mit Da-

tenbanken, die kostenlos nutzbar sind, wie z.B. PubMed oder den Katalogen einzelner Bib-

liotheken. 
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Die andere Möglichkeit ist der Direct Export. Hier recherchieren Sie in der Datenbank direkt 

und exportieren die Ergebnisse der Recherche aus der Datenbank nach EndNote. Für die 

Recherche in lizenzierten Datenbanken, für die Sie sich mit Ihrer Uni-ID anmelden müssen, 

ist nur der Direct Export möglich. 

Der Direct Export ist auch deswegen der Online Search vorzuziehen, weil Datenbanken 

i.d.R. über Möglichkeiten zur Unterstützung der Suche und der Trefferauswertung verfügen, 

die die Online Search nicht abbilden kann. Dazu gehören Suchwerkzeuge wie Thesauri 

oder die Listensuche zur Ermittlung von Suchbegriffen bzw. der korrekten Eingabeform o-

der die Suchhistorie, über die die Ergebnisse verschiedener Suchanfragen nachträglich 

miteinander verknüpft werden können. (Zu große) Treffermengen können durch Filter ein-

geschränkt werden. Ferner kann man sich die Treffer nach unterschiedlichen Aspekten sor-

tiert anzeigen lassen. 

 

4.1  Direct Export aus dem Heidelberger Bibliothekskatalog HEIDI 

Gehen Sie beim Direct Export aus dem Heidelberger Bibliothekskatalog HEIDI wie folgt vor: 

1. Führen Sie Ihre Suche im Katalog HEIDI wie gewohnt durch. 

2. Markieren Sie die Treffer, die Sie in Ihre EndNote-Bibliothek übernehmen möchten (mit 

dem Markierungssymbol  rechts neben der Anzeige des Treffers). 

3. Die markierten Treffer werden in der Merkliste, die als Exportordner fungiert, angezeigt. 

4. Wechseln Sie für den Export in die Merkliste. Sie haben hier die Möglichkeit, die Treffer 

vor dem Export zu sichten. Falls Treffer dabei sind, die Sie doch nicht übernehmen 

möchten, löschen Sie die Häkchen vor den Titeln. Wählen Sie im Dropdown-Menü For-

mat das Exportformat RIS (EndNote) aus und klicken Sie auf Speichern. 

5. Klicken Sie im nächsten Fenster auf Öffnen mit: EndNote 20 (oder ResearchSoft Direct 

Export Helper (Standard)) und bestätigen Sie die Auswahl mit OK. Falls an dieser Stelle, 

abhängig von Ihren Einstellungen, gefragt wird, mit welchem Programm die Exportdatei 

geöffnet werden soll, wählen Sie EndNote 20 aus. 

6. Die Titel der Importdatei werden in Ihre EndNote-Bibliothek übernommen und in der 

Reference List angezeigt. Dabei werden sie sowohl der Gruppe All References als auch 

den Gruppen Imported References und Recently Added zugeordnet: 

 

 
 
Der Inhalt der Gruppe Imported References wird immer mit dem neuesten Suchergebnis 
überschrieben. In der Gruppe Recently Added werden alle Neuzugänge Ihrer EndNote-
Bibliothek 24 Stunden lang angezeigt. 

https://www.ub.uni-heidelberg.de/helios/kataloge/heidi.html
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Hinweis:  Überprüfen Sie Ihre Daten nach einem Import. Datenbanken ähneln sich, 

je nachdem, ob es sich um einen Bibliothekskatalog, eine Literaturdaten-

bank oder eine EndNote-Bibliothek handelt, hinsichtlich Struktur und den 

Regeln für die Datenerfassung. Es gibt jedoch auch Unterschiede, die 

der Grund dafür sein können, dass die Angaben nach einem Import nicht 

automatisch in den richtigen Feldern landen. In solchen Fällen müssen 

Sie manuell korrigieren, damit die Referenzen später auch korrekt in Ih-

rer Literaturliste angezeigt werden. 

 

4.2 Export aus HEIDI mit manuellem Import nach EndNote inkl. Dublettenkontrolle 

1. Führen Sie die Schritte 1 bis 4 durch, wie in Abschnitt 4.1. beschrieben. 

2. Klicken Sie auf Datei speichern. 

3. Wechseln Sie zu EndNote und führen Sie die Befehle File > Import > File aus. 

4. In dem sich öffnenden Fenster suchen Sie im ersten Feld nach der Importdatei heidi.ris 

(sie wird i.d.R. im Downloadordner gespeichert). Im zweiten Feld wird der korrekte Im-

portfilter, hier Reference Manager (RIS), eingetragen. Im dritten Feld können Sie zwi-

schen Import All (dann werden alle Referenzen der Importdatei in Ihre EndNote-Biblio-

thek übernommen) oder Discard Duplicates wählen. Wird Discard Duplicates ausge-

wählt, führt EndNote beim Import eine automatische Dublettenkontrolle durch und über-

nimmt nur die Referenzen, die noch nicht in Ihrer EndNote-Bibliothek vorhanden sind. 

Die Kriterien für die Dublettenkontrolle können über Edit > Preferences > Duplicates 

geändert werden. 

 

 
 

 

Tipp:  Diese Art des Imports mit Dublettenkontrolle ist auch bei Importen aus 

anderen Datenbanken möglich. 

 
4.3  Direct Export aus Literaturdatenbanken 

Der Export aus anderen Datenbanken funktioniert ähnlich. 

1. Markieren Sie die zu importierenden Treffer. 

2. Klicken Sie je nach Datenbank auf Export, Speichern / Save oder Send To. 

3. Wählen Sie je nach Datenbank das Exportformat EndNote, RIS oder Citation Manager 

(für den Export aus PubMed) aus. 
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Beispiel: Export aus der MLA International Bibliography (Datenbankanbieter: EBSCO) 

a) Markieren Sie die Treffer, die Sie nach EndNote exportieren möchten. 

b) Klicken Sie auf Go to Folder View, um den Exportordner aufzurufen. 

 

 
 

c) Klicken Sie auf Select all oder markieren Sie einzelne Treffer, die Sie übernehmen 

möchten. 

d) Klicken Sie auf Export. 

 

 
 

e) Klicken Sie auf Direct Export in RIS Format … und danach auf Save: 
 

 
 

4.4  Online-Search am Beispiel von PubMed 

Aus EndNote heraus können Sie in kostenlos zu nutzenden Datenbanken recherchieren, 

indem Sie im Groups Panel unter Online Search auf die entsprechende Datenbank, z.B. 

PubMed, klicken. Alternativ können Sie die Online Search in PubMed im Menü über Tools 

> Online Search aufrufen. Darauf öffnet sich ein Fenster mit einer Auflistung durchsuchba-

rer Datenbanken. Markieren Sie PubMed und bestätigen Sie Ihre Auswahl mit Choose. 
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Über der Suchmaske erscheint nun rechts oben der Name der ausgewählten Datenbank. 

Die Feldnamen in den Suchfeldern sind entsprechend angeglichen: 

 

 
 

Geben Sie Ihre Suchbegriffe ein und klicken Sie auf Search: 

 

 
 

Standardmäßig werden die ersten 25 Treffer angezeigt, weitere Treffer können über Re-

trieve Results geladen werden. Die Treffer sind zunächst temporär der Gruppe PubMed 

zugeordnet. Bei der Durchsicht der Trefferliste werden thematisch geeignete Treffer mar-

kiert. Mit Klick auf den Button mit dem Pluszeichen können sie in die eigene EndNote-Bib-

liothek übernommen werden. 
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Tipp:  Standardmäßig werden bei der Installation des Programms über 400 

Connection Files angeboten. Weitere Connection Files, zum Beispiel für 

den Südwestdeutschen Bibliotheksverbund, finden Sie auf der Website 

des Anbieters. 

 

 
 

 

5 Suche in der EndNote-Bibliothek 

5.1  Die Advanced Search 

Bitte wählen Sie zunächst durch Anklicken von All References oder einer einzelnen Gruppe 

aus, ob Sie alle Referenzen Ihrer Bibliothek oder eine bestimmte Gruppe durchsuchen 

möchten. EndNote startet standardmäßig mit der Advanced Search, einer Suchmaske mit 

mehreren Suchfeldern. Die Suchmaske kann auch über das Menü mit Library > Advanced 

Search aktiviert werden. 

 

 
 

 

Standardmäßig werden drei Suchfelder angeboten. Weitere können über die Schaltfläche 

„+“ hinter dem Suchfeld hinzugefügt werden. In jedem Feld lässt sich per Dropdownmenü 

ein Suchaspekt einstellen, was präzise formulierte Suchanfragen ermöglicht, z.B. 

Auswahl Suchaspekt 

Boolesche Operatoren zur Verknüpfung der Felder 

http://swb.bsz-bw.de/DB=2.1/?COOKIE=Us998,Pbszgast,I2017,B20728+,SY,NRecherche-DB,D2.1,E8153b566-0,A,H,R217.225.129.36,FY
https://endnote.com/downloads/connection-files/
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 Author: Suche nach Namen 

 Title: Suche nach Titelstichwörtern 

 Keywords: Suche nach Schlagwörtern 

 PDF: Suche in (maschinenlesbaren) PDF-Anhängen 

 PDF Notes: Suche in PDF-Notizen (Sticky Notes) 

 Any Field: Suche in allen Feldern gleichzeitig 

Any Field + PDF with Notes: gleichzeitige Suche in allen Feldern, PDF-Anhängen 

und -Notizen 

In der Spalte rechts neben der Auswahl der Suchaspekte können über ein Dropdown-Menü 

Vergleichs-Operatoren zur Präzisierung eines Suchbegriffes ausgewählt werden. Wenn Sie 

nur die neueste Literatur, z.B. ab 2018, finden möchten, können Sie im Feld Year „2018“ 

eingeben und die Option Is greater than or equal to auswählen. Ihnen werden dann nur die 

Referenzen mit Erscheinungsjahr ab 2018 und jünger angezeigt. Die einzelnen Suchfelder 

können mit den Booleschen Operatoren AND / OR / NOT verknüpft werden. 

Eingegebene Suchbegriffe werden automatisch links und rechts trunkiert. Wird in der 

Sample Library beispielsweise der Suchbegriff „bat“ im Titelfeld eingegeben, werden auch 

Treffer mit dem Begriff „bats“ im Titel gefunden. 

Geben Sie in dieser Suchmaske bei einer Suche mit mehreren Begriffen pro Feld nur 

einen Begriff ein (mehrere Begriffe in einer Zeile werden als Phrase gesucht) und verknüp-

fen Sie die einzelnen Felder mit AND. 

 

5.2  Die Simple Search 

 

 
 

Über die Schaltfläche Simple Search lässt sich ein einfaches Suchfeld aufrufen. Bei einer 

Simple Search werden alle Felder inkl. PDF-Anhängen und -Kommentaren durchsucht. 

Mehrere Suchbegriffe werden automatisch mit AND verknüpft. 

 

 

6 Referenzen mit Hilfe von Gruppen verwalten 

6.1  Die Gruppenfunktionen 

Es empfiehlt sich, nur eine EndNote-Bibliothek zu nutzen und mit Hilfe von Gruppen zu 

unterschiedlichen Themen / Aspekten für Ordnung und Übersichtlichkeit zu sorgen. Sie 

können bis zu 5.000 Gruppen anlegen. 

Es gibt verschiedene Arten von Gruppen: Custom Groups (= selbstangelegte Gruppen) 

und Smart Groups, die auch anhand ihrer unterschiedlichen Icons vor den Gruppennamen 

erkennbar sind: 
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6.2  Groups und Group Sets 

Eine einzelne Custom Group wird über Groups > Create Group angelegt. Einzelne oder 

mehrere markierte Referenzen können per Drag & Drop manuell einer Gruppe zugeordnet 

werden. Man kann auch Referenzen markieren, das Kontextmenü mit der rechten Maus-

taste aufrufen und sie über Add References to einer bereits bestehenden oder neu anzule-

genden Gruppe zuordnen. Eine Referenz kann mehreren Gruppen zugeordnet werden. 

Wird eine Gruppe gelöscht (Gruppe markieren > Kontextmenü über rechte Maustaste auf-

rufen > Delete Group), wird lediglich die Verknüpfung zwischen Referenz und Gruppe ge-

löscht. Die Referenzen selbst bleiben erhalten. 

Eine übergeordnete Custom Group wird über Groups > Create Group Set erstellt. Per 

Drag & Drop können ihr Custom Groups zugeordnet werden. 

Den Namen einer Gruppe können Sie ändern, indem Sie die Gruppe markieren und über 

das Kontextmenü Rename Group wählen. 

Wenn Sie wissen möchten, welchen Gruppen eine Referenz zugeordnet ist, markieren 

Sie die Referenz und rufen Sie über das Menü Reference > Record Summary auf. 

Referenzen, die noch keiner Custom Group zugeordnet sind, werden in der Standard-

gruppe Unfiled angezeigt. 

 

6.3  Smart Groups 

Smart Groups werden aus einer Suchanfrage heraus generiert, indem die Referenzen, die 

den Suchkriterien entsprechen, der Smart Group automatisch zugeordnet werden. Neu in 

die EndNote-Bibliothek aufgenommene Referenzen, die den Suchkriterien entsprechen, 

werden der Smart Group künftig automatisch zugeordnet. 

Mit Hilfe einer Smart Group kann eine ganze EndNote-Bibliothek inkl. PDF-Anhängen 

sehr schnell nach Begriffen durchsucht werden. 

Um eine Smartgroup zu erstellen, geben Sie Ihre Suchbegriffe in die Suchmaske ein 

und klicken auf Options > Convert to Smart Group. 

Group Set 

Custom Group 

Smart Group 

Combined From 

Groups 
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Die gefundenen Referenzen werden einer Gruppe mit dem Namen Converted Search zu-

geordnet. 

Alternativ können Sie eine Smart Group auch über Groups > Create Smart Group an-

legen. In der Suchmaske können Sie gleich einen Namen für die Smart Group vergeben. 

 

6.4  Create from Groups 

Mit der Funktion Create from Groups kann man in einer Suchanfrage bestehende Gruppen 

miteinander kombinieren und so Schnittmengen bilden. 

 

 
 

6.5  Gruppen teilen 

Wenn Sie einen EndNote-Online-Account zur Synchronisierung Ihrer EndNote-Bibliothek 

nutzen (s. dazu Kap. 14), können Sie einzelne Gruppen mit anderen Nutzern teilen und 

diesen Nutzern lesenden und schreibenden oder nur lesenden Zugriff zuweisen.  Markieren 

Sie dazu die Gruppe und klicken Sie auf Groups > Share Group. Im nächsten Fenster haben 

Sie die Möglichkeit, andere EndNote-Nutzer einzuladen. 

 

 

7 Referenzen ergänzen, ändern und mit Dateien verknüpfen 

EndNote bietet Ihnen die Möglichkeit, Ihre Referenzen zu ändern und zu ergänzen, z.B. mit 

Informationen zur inhaltlichen Beschreibung oder eigenen Notizen zu versehen. Ihre eige-

nen Schlagwörter können Sie im Feld Keywords, eine Zusammenfassung des Inhalts eines 

Dokuments im Feld Abstracts erfassen. Anschließend ist auch eine gezielte Suche nach 

diesen Informationen möglich. 

Das Feld Research Notes steht Ihnen für eigene Notizen, Ideen etc. zur Verfügung. 

Beim Lesen von Volltexten können Sie dort Text-Auszüge, z.B. aus einer PDF-Datei, mit 

Copy & Paste erfassen, die Sie später in einem Dokument zitieren möchten. 

Namen vergeben 

Gruppe aus Dropdown-

Menü auswählen 
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Über die Schaltfläche Attach File in der Summary- und Edit-Ansicht oder über Refe-

rences > File Attachments > Attach File können Sie Ihre Referenzen mit bis zu 45 Dateien 

verknüpfen. In der Regel wird es sich dabei um PDF-Dateien handeln. Diese können Sie in 

EndNote in der Summary-Ansicht über die Schaltfläche mit dem Namen der PDF-Datei und 

Klick auf Open in einem eigenen Fenster innerhalb von EndNote öffnen. Sie können die 

PDF-Datei lesen, im Volltext durchsuchen und bearbeiten. Zum Bearbeiten der PDF-Datei 

klicken Sie links oben auf das Icon Markup/annotation, um die Werkzeugleiste aufzuklap-

pen. 

Wenn Sie die PDF-Datei außerhalb von EndNote lesen möchten, wählen Sie die Option 

Open with Adobe Acrobat Reader DC. 

Andere mit einer Referenz verknüpfte Dateitypen werden zum Lesen und Bearbeiten 

außerhalb von EndNote mit dem dazugehörigen Programm geöffnet. 

Pro Referenz kann eine Bild-Datei über References > Figure > Attach Figure mit einer 

Referenz verknüpft werden. Im Feld Capture können Bildunterschriften erfasst werden. Bild 

und Bildunterschrift können Sie über das EndNote-Add-In in Word in Dokumente einfügen 

(Insert Citation > Insert Figure). 

 

 

8 Suche nach frei verfügbaren und lizenzierten Volltexten 

Um ein optimales Ergebnis bei der Suche nach Volltexten, i.d.R. PDF-Dateien, zu errei-

chen, sollten Sie über Edit > Preferences > Find Full Text folgende Einstellungen vorneh-

men: 

 

 
 

Wenn Sie Mitglied der Universität Heidelberg sind, tragen Sie bei Open URL Path 

„http://www.redi-bw.de/links/unihd“ ein, damit aus EndNote heraus über die Open-URL-

Link-Funktion und den Link-Resolver der Universitätsbibliothek Volltexte aus lizenzierten 

Zeitschriften und Büchern ermittelt werden können. 
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Über die Funktion Find Full Text kann nach frei verfügbaren Volltexten gesucht werden, die 

EndNote automatisch mit der Referenz verknüpft. Markieren Sie dazu eine oder mehrere 

Referenzen und klicken Sie auf References > Find Full Text. 

Im aufgeklappten Gruppenfenster Find Full Text können Sie nun den Verlauf der Suche 

und das Ergebnis beobachten: 

 

 
 

Die Referenzen, für die kein frei verfügbarer Volltext gefunden wurde, werden in der Gruppe 

Not found angezeigt. Für sie kann über die Open-URL-Link-Funktion nach Volltexten aus 

lizenzierten Zeitschriften und Büchern weitergesucht werden. Markieren Sie dazu die Re-

ferenz, rufen Sie mit der rechten Maustaste das Kontextmenü auf und klicken Sie dann auf 

URL > Open URL Link. Als nächstes öffnet sich ein Fenster mit den Ergebnissen der auto-

matisch durchgeführten Suche in HEIDI: 

 

 
 

Ein Klick auf Zum Volltext … führt Sie zum Downloadlink der gesuchten Publikation. Laden 

Sie die Publikation herunter und verknüpfen Sie sie manuell mit der zugehörigen Referenz. 
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Hinweis:  Bitte beachten Sie bei der Nutzung von Volltexten die Nutzungsbedin-

gungen der Verlage / Herausgeber und die Bestimmungen des Urheber-

rechts. 

Sollte kein elektronischer Volltext vorhanden sein, finden Sie unter Lo-

kale Verfügbarkeit (Katalogsuche) Informationen zu Printausgaben in 

Heidelberger Bibliotheken. 

Nicht in Heidelberg vorhandene Publikationen können Sie über Fern-

leihe oder überregionale Dokumentlieferdienste wie Subito bestellen. 

 

 

 

9 Dublettenkontrolle 

Bevor Sie anfangen, Referenzen in Ihre Dokumente einzufügen, sollten Sie Ihre EndNote-

Bibliothek auf doppelt vorhandene Datensätze überprüfen und diese löschen, da dublette 

Referenzen beim Schreiben von Dokumenten Schwierigkeiten verursachen können. 

Achten Sie darauf, dass die Gruppe All References markiert ist und klicken Sie auf 

Library > Find Duplicates. Es öffnet sich ein Fenster, in dem dublette Datensätze nebenein-

ander angezeigt werden. Sie können in der Anzeige nach unten scrollen. Unterschiede in 

der Feldbelegung werden hervorgehoben: 

 

 
 

Wenn Sie entschieden haben, welche Referenz Sie behalten möchten, klicken Sie auf Keep 

This Record. Die andere Referenz wird aus Ihrer Datenbank gelöscht. 

 

 

Scrollen 

https://www.ub.uni-heidelberg.de/helios/epubl/ej/nutzung.html
https://www.ub.uni-heidelberg.de/helios/epubl/ej/nutzung.html
https://www.ub.uni-heidelberg.de/allg/benutzung/bereiche/fernl.html
https://www.ub.uni-heidelberg.de/allg/benutzung/bereiche/fernl.html
https://www.ub.uni-heidelberg.de/helios/EDD/auswaertige.html
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10 Referenzen in Word-Dokumente einfügen 

10.1  Referenzen in ein Word-Dokument einfügen und formatieren 

Über das Word-Add-In CWYW (Cite While You Write), das nach der Installation von End-

Note in Word als Registerkarte im Menüband zu sehen ist, können Sie beim Schreiben 

Referenzen in Ihrer EndNote-Bibliothek suchen und einfügen, ohne Ihr Word-Dokument zu 

verlassen. Ferner können Sie Zitate editieren und Literaturlisten formatieren. 

 

 
 

 
 

10.2  Referenzen einfügen und einen Zitierstil zuweisen 

Wenn Sie ein Zitat in ein Dokument einfügen möchten, vergewissern Sie sich, dass Ihre 

EndNote-Bibliothek im Hintergrund geöffnet ist und der Cursor an der Stelle steht, an der 

das Zitat eingefügt werden soll. Klicken Sie dann auf Insert Citation. Es öffnet sich ein Fens-

ter, in dem Sie z.B. nach Autorennamen, Titelstichwörtern oder anderen Begriffen in allen 

Feldern Ihrer EndNote-Bibliothek suchen können. Markieren Sie in der Liste der angezeig-

ten Treffer die Referenz, die Sie zitieren möchten und klicken Sie auf Insert. 

 

 
 

Das Zitat wird nun im Text eingefügt und die Literaturliste am Ende des Dokumentes wird 

automatisch aktualisiert. Die Darstellung der Zitate im Text und der Referenzen in der Lite-

raturliste wird über den eingestellten Zitierstil geregelt. Ihnen stehen im Dropdown-Menü 

Referenzen 

suchen und 

einfügen 

Referenzen 

editieren oder 

löschen 

Zitierstil aus-

wählen 

Zitate und 

Bibliographie 

aktualisieren 

Automatisches 

Formatieren ein- 

/ ausschalten 

Suchfeld 

Anzeige der gefundenen Referenzen 
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die gleichen Stile wie in EndNote zur Verfügung. Sie können auch hier im Dropdown-Menü 

über Select Another Style weitere Stile aus dem Style Manager übernehmen. 

Im Folgenden sehen Sie je ein Beispiel für den Author-Date-Stil und den Stil Numbered: 

 

 
 

 
 

Falls Sie einen Fußnoten-Stil benutzen, fügen Sie erst die Fußnote ein. Bei Word für 

Windows geht dies am schnellsten mit der Tastenkombination „Strg + Alt + F“, ansonsten 

über Referenzen > Fußnote einfügen. Suchen Sie dann über Insert Citation nach der Refe-

renz, die Sie zitieren möchten und fügen Sie diese mit Klick auf Insert ein. 

Beispiel für einen Fußnotenstil: 
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Tipp:  Während des Schreibens können Sie im Prinzip jederzeit den Stil wech-

seln. Bevor Sie anfangen zu schreiben, sollten Sie sich allerdings überle-

gen, ob Sie einen Stil vom Typ Author Date bzw. Numbered oder einen 

Fußnoten-Stil benutzen möchten, da ein nachträglicher Wechsel zwischen 

diesen unterschiedlichen Stiltypen nicht möglich ist. 

 

10.3  Zitate im Text editieren 

Falls Sie in den Zitaten Text hinzufügen und Seitenangaben zitieren möchten, markieren 

Sie das Zitat und klicken Sie dann auf Edit and Manage Citations. Es öffnet sich ein Fenster 

mit der Liste aller in Ihrem Dokument zitierten Referenzen. In der unteren Hälfte werden die 

drei Felder Prefix, Suffix und Pages angezeigt, in denen Sie Ihre Eintragungen vornehmen 

können. 

 Prefix: Angaben werden vor der Literaturangabe in der Klammer / Fußnote ange-

zeigt. 

 Suffix: Angaben werden nach der Literaturangabe in der Klammer / Fußnote ange-

zeigt. 

 Pages: Für die Eingabe einzelner Seitenangaben. Über den Zitierstil werden For-

mulierungen wie „S.“ automatisch hinzugefügt. Allerdings unterstützt nicht jeder Zi-

tierstil dieses Feld. Über eine Zitierstiländerung lässt sich ein Stil so ändern, dass er 

Eingaben im Feld Pages unterstützt (s. dazu die Anleitung zu Zitierstiländerungen 

in EndNote). 

 

 
 

 

10.4  Referenzen korrigieren 

Wenn Sie in Ihrem Word-Dokument bei einer verwendeten Referenz einen Tippfehler ent-

decken oder feststellen, dass die bibliographischen Angaben in der Literaturliste nicht kor-

rekt angezeigt werden, muss die Referenz in EndNote manuell korrigiert werden. Speichern 

Sie die Korrektur in EndNote ab. Klicken Sie anschließend in Word auf Update Citations 

and Bibliography. Zitate und Literaturliste werden automatisch aktualisiert. 

 

(Vergl. Pepperberg 1999, S. 34) 

https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/materialien/Zitierstile.pdf
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/materialien/Zitierstile.pdf
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10.5  Zitate löschen 

Wenn Sie mit Word arbeiten und eine Referenz aus dem Text löschen möchten, benutzen 

Sie dafür nie die Delete-Taste, denn das kann Ihr Dokument auf die Dauer beschädigen. 

Markieren Sie stattdessen im Text oder in der Fußnote das zu löschende Zitat und klicken 

Sie auf Edit and Manage Citations. 

Rufen Sie das Dropdown-Menü der markierten Referenz auf, wählen Sie Remove Ci-

tation und bestätigen Sie die Auswahl mit OK. Das Zitat wird damit sowohl aus dem Text 

als auch aus der Literaturliste herausgelöscht. 

 

 
 

10.6  Literaturlisten formatieren 

Wenn Sie für Ihre Literaturliste eine Überschrift vergeben möchten, klicken Sie bei Biblio-

graphy auf das kleine Pfeil-Symbol rechts unten. Im Fenster Configure Bibliography klicken 

Sie auf den Tab Layout. Im Feld Bibliography Title können Sie eine Überschrift eintragen. 
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10.7  Literaturlisten in mehrere Einzellisten aufteilen 
Falls Sie statt einer Literaturliste mehrere Einzellisten, z. B. separate Listen für Primär- und 

Sekundärliteratur für eine Arbeit im Bereich der Literaturwissenschaft haben möchten, kön-

nen Sie über die Funktion Categorize References > Configure Categories die Literatur ver-

schiedenen Gruppen zuordnen. 

Zwei Gruppen mit den Namen Primary Sources und Secondary Sources sind standard-

mäßig vorhanden, weitere können hinzugefügt werden. Die Gruppen können umbenannt 

werden (mit der rechten Maustaste das Kontextmenü aufrufen > Rename). In der Gruppe 

All References in Bibliography finden Sie die im Word-Dokument zitierten Referenzen, die 

Sie per Drag & Drop den Gruppen zuordnen können. Noch nicht zugeordnete Referenzen 

finden Sie in der Gruppe Uncategorized References. Beenden Sie die Zuordnung der Re-

ferenzen mit Klick auf OK. Die Literaturliste wird dadurch neu sortiert in mehrere Einzellisten 

mit eigenen Überschriften. 

 

 
 

10.8 Automatisches Formatieren aus- und einschalten 

Das Einfügen von Referenzen kann Ihren Rechner u.U. vor allem bei umfangreicheren Do-

kumenten ausbremsen, weil das automatische Aktualisieren der Literaturliste Rechenzeit 

bindet. Das automatische Aktualisieren lässt sich ausschalten, indem Sie auf Instant For-

matting is On klicken und Turn Instant Formatting Off wählen. Zitate werden in diesem Mo-

dus in vorläufiger Form, erkennbar an der geschweiften Klammer und der Angabe der Num-

mer des Datensatzes, im Text eingefügt. 

Beispiel: 

 

 
 

Mit Update Citations and Bibliography können die vorläufigen in endgültige Zitate umge-

wandelt und die Literaturliste aktualisiert werden. 

Wenn Sie das automatische Formatieren wieder einschalten möchten, klicken Sie auf 

Instant Formatting is Off > Turn Instant Formatting On. 

 

 

11 Zitierstile auswählen, ändern oder neu erstellen 

11.1  Zitierstile in EndNote oder Word auswählen 

Den Zitierstil können Sie über das Dropdown-Menü im Preview-Panel bei EndNote einstel-

len. Nach der Programminstallation stehen Ihnen ca. 500 häufig genutzte Zitierstile zur Ver-

fügung, die Sie über das Dropdown-Menü zur Auswahl eines Zitierstiles mit Select Another 

Style oder über Tools > Output Styles > Open Style Manager … aufrufen können. Weitere 
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Zitierstile können Sie von der EndNote-Homepage (Aufruf auch über „Help > EndNote Out-

put Styles“) herunterladen. 

 

11.2  Zitierstile an der Universität Heidelberg 

Wenn Sie an der Universität Heidelberg studieren, werden Sie in der Regel die Zitiervorga-

ben der Fakultät oder Ihres Dozenten beachten müssen. Einige mit den Instituten bzw. Fa-

kultäten abgestimmte Zitierstile sind über die Schulungsseite der Universitätsbibliothek ab-

rufbar. Die Liste wird kontinuierlich erweitert. 

 

11.3  Zitierstile ändern oder neu erstellen 

Wenn Sie keinen passenden Zitierstil finden, können Sie einen eigenen Zitierstil erstellen 

bzw. einen bereits vorhandenen Zitierstil an die eigenen Bedürfnisse anpassen. 

Stellen Sie dazu in EndNote den Stil ein, den Sie ändern möchten, und rufen Sie dann 

über Tools > Output Styles > Edit „XXX“ den Style Editor auf. Bevor Sie mit den Änderungen 

beginnen, sollten Sie den Stil mit File > Save as unter neuem Namen abspeichern, damit 

Sie jederzeit auf den Originalstil zurückgreifen können. 

Die wichtigsten Rubriken eines Zitierstiles sind Citations, Bibliography und Footnotes: 

 

 
 

In den Templates wird das Aussehen der Zitate im Text bzw. in den Fußnoten sowie der 

Referenzen in der Literaturliste geregelt. Außerdem wird in einem Zitierstil z.B. festgelegt, 

ob Namen ausgeschrieben oder abgekürzt, wie viele Namen bei mehreren Autoren zitiert 

und wie mit wiederholten Zitaten verfahren werden soll. 

Eine vollständige Anleitung zum Erstellen eigener Zitierstile in EndNote finden Sie ebenfalls 

auf den Schulungsseiten der Universitätsbibliothek. 

 

 

12 Unabhängige Literaturlisten erstellen 

Mit EndNote können Sie aus Ihren Referenzen auch unabhängige, also nicht mit einem 

Dokument verknüpfte Literaturlisten erstellen. 

 

https://endnote.com/downloads/styles/
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/materialien/Zitierstile.pdf
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12.1  Einfache Literaturlisten 

Eine einfache Literaturliste können Sie schnell erstellen, indem Sie die dafür vorgesehenen 

Referenzen markieren und auf File > Export klicken. In dem sich öffnenden Fenster verge-

ben Sie einen Namen für die Exportdatei und wählen das Dateiformat (z.B. rtf) sowie den 

Zitierstil für die Literaturliste aus. Setzen Sie ein Häkchen vor Export Selected References 

und klicken Sie auf Speichern. 

 

12.2  Subject Bibliographies  
Sie können nach bestimmten Kriterien (z.B. Autorennamen oder Schlagwörtern) geordnete 

Literaturlisten erstellen. Klicken Sie dazu auf Tools > Subject Bibliography. Darauf öffnet 

sich ein Fenster mit einer Liste aller Felder, aus deren Inhalten Sie Literaturlisten erstellen 

können: 

 

 
 

Markieren Sie z.B. für eine nach Schlagwörtern geordnete Liste in der Auswahl Keywords. 

Sie erhalten als nächstes eine Liste aller in Ihrer EndNote-Bibliothek verwendeten Schlag-

wörter. Sie können alle Schlagwörter in Ihre Liste übernehmen oder einzelne Begriffe bei 

gedrückter STRG-Taste mit der Maus markieren. Bestätigen Sie Ihre Auswahl mit OK. Im 

nächsten Fenster können Sie Ihre Literaturliste über den Reiter Layout formatieren und den 

Zitierstil auswählen. 
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Die Literaturliste können Sie mit Save im RTF-Format abspeichern. 

 

 

13 Referenzen sichern 

Sie sollten in regelmäßigen Abständen Ihre EndNote-Datenbank sichern. EndNote bietet 

dafür die Funktionen Save a Copy und Compressed Library an. Mit Save a Copy wird eine 

Kopie einer EndNote-Bibliothek erstellt, bestehend aus der enl.Datei und dem DATA.Ord-

ner. Mit der Funktion Compressed Library wird aus der enl.Datei und dem DATA.Ordner 

eine einzelne, komprimierte Datei mit der Dateiendung .enlx erstellt, die sich mit einem Klick 

auf den Dateinamen wieder öffnen lässt. Diese Archived Library lässt sich als E-Mail-An-

hang verschicken und ist daher auch für den Austausch geeignet. Eine Compressed Library 

kann auch für einzelne markierte Referenzen oder eine Custom Group erstellt werden, 

wahlweise mit oder ohne PDF-Dateianhänge. 

Um eine Compressed Library zu erstellen, klicken Sie auf File > Compressed Library. 

Nehmen Sie in dem Fenster Compressed Library die gewünschten Einstellungen vor und 

klicken Sie auf Next, um den Speicherort und den Dateinamen festzulegen. 

 

 
 

 

14 Synchronisation mit EndNote Online 

EndNote Online ist die webbasierte Anwendung von EndNote. Ein EndNote-Online-Ac-

count ermöglicht es Ihnen, Ihre Daten in einer Cloud zu speichern. (Es handelt sich um die 

Cloud des EndNote-Herstellers und ist damit die einzige Cloud, die im Zusammenspiel mit 

EndNote ohne Probleme funktioniert.) Damit steht Ihnen eine Sicherheitskopie Ihrer End-

Note-Bibliothek zur Verfügung. Außerdem können Sie Ihre EndNote-Bibliothek zwischen 

verschiedenen Rechnern synchronisieren. Ein EndNote-Online-Account ist auch die Vo-

raussetzung dafür, dass Sie mit anderen EndNote-Desktop-Anwendern die Daten Ihrer 

EndNote-Bibliothek gemeinsam nutzen können, z.B. mittels Library Sharing (s. Kap. 15). 

Als Mitglied der Universität Heidelberg können Sie sich einen kostenlosen EndNote-

Online-Account einrichten. Die Nutzung ist zunächst auf zwei Jahre befristet. Das EndNote-

Online-Abonnement kann aber durch ein Upgrade auf die jeweils neueste EndNote-Version 

verlängert werden.  

Rufen Sie die EndNote-Online-Seite zum Anlegen eines EndNote-Online-Accounts in 

EndNote mit Help > EndNote online auf und klicken Sie auf den Button Register. Verwenden 

Sie für die Anmeldung eine E-Mail-Adresse der Universität Heidelberg. 
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Tragen Sie in EndNote über Edit > Preferences > Sync E-Mail-Adresse und Password Ihres 

EndNote-Online-Accounts ein und klicken Sie auf Enable Sync. 

Mit Library > Sync können Sie nun Ihre Referenzen zwischen EndNote Desktop 

und EndNote Online synchronisieren. 

 

 

Hinweis:  Es kann nur eine EndNote-Bibliothek synchronisiert werden. 

 

Sie können beim Schreiben von Word-Dokumenten auch Ihre EndNote-Online-Datenbank 

nutzen. Klicken Sie dazu in Word auf Preferences und im nächsten Fenster auf Application 

> Application und wählen Sie dort EndNote Online aus. Der EndNote-Tab im Word-Menü-

band ändert sich entsprechend, da für die Arbeit mit EndNote Online weniger Funktionen 

in Word zur Verfügung stehen. 

 

 
 

Weitere Informationen zur Arbeit mit EndNote Online finden Sie hier auf den Seiten des 

Anbieters  und im Quick Reference Guide for Online 

 

 

15 Library Sharing 

Mit Library Sharing können bis zu 100 Teilnehmer gleichzeitig mit einer gemeinsam geführ-

ten EndNote-Bibliothek arbeiten. Für die gemeinsame Datenbank gibt es keine Beschrän-

kung in der Cloud. Informationen in deutscher Sprache zum Einrichten und Nutzen von 

Library Sharing finden Sie auf den Support-Seiten von Alfasoft2. 

 

 

                                                           

2  Die Alfasoft GmbH (https://www.adeptscience.de/ ), Nachfolgerin der Adeptscience GmbH, 
bietet für den deutschsprachigen Raum Software, u.a. EndNote, inkl. Schulungen und Support an. 

https://www.adeptscience.de/products/refman/endnote/endnoteneuX72.html
https://support.clarivate.com/Endnote/servlet/fileField?entityId=ka14N000000EcsXQAS&field=CA_Attachment_1__Body__s
https://www.adeptscience.de/products/refman/endnote/endnoteneuX72.html
https://www.adeptscience.de/
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16 Anhang 

16.1  Liste der Referenztypen 

 

Aggregated Database Aggregierte Daten 

Ancient Text Werk, das von einem Autor geschrieben und von einem 
Editor bearbeitet wurde. 

Artwork Kunstwerk 

Audiovisual Material Audiovisuelle Medien (z.B. Film, Video, DVD, CD, Ton-
kassette) 

Bill Gesetzesentwurf, Gesetz 

Book Buch 

Book Section Beitrag in einem Sammelband 

Case Rechtsfall, Klage, Prozessunterlagen 

Catalog Katalog 

Chart or Table Grafik, Tabelle, Diagramm 

Classical Work Altsprachliches, klassisches Werk 

Computer Program Computerprogramm 

Conference Paper Einzelner Beitrag zu einer Tagung 

Conference Proceeding Tagungsbericht 

Dataset Datei 

Dictionary Eintrag aus einem Wörterbuch 

Edited Book Sammelband (= von einem Hrsg. editiertes Werk) 

Electronic Article Elektronischer Aufsatz 

Electronic Book Elektronisches Buch 

Electronic Book Section Beitrag aus einem elektronischen Sammelband 

Encyclopedia Eintrag aus einer Enzyklopädie 

Equation Gleichung, Vergleich 

Figure Bild, Abbildung 

Film or Broadcast Film, Rundfunksendung 

Generic Allgemeiner Publikationstyp 

Government Document Amtsdruckschrift (Veröffentlichungen von Regierungen 
und amtlichen Stellen) 

Grant Bewilligungsschreiben, Verleihungsschreiben 

Hearing Gerichtsvernehmung 

Interview Interview 

Journal Article Artikel in einer Fachzeitschrift 

Legal Rule or Regulation Gesetz, Verordnung 

Magazine Article Artikel in einer Zeitschrift 

Manuscript Handschrift, Druckvorlage 

Map Karte 

Music Noten, Notenheft 

Newspaper Article Artikel in einer Zeitung 

Online Database Online-Datenbank 

Online Multimedia Online-Medienkombination (= Werke, die aus mehreren 
Medien bestehen, z.B. Text, Grafik, Audio, Video, Anima-
tion) 

Pamphlet Broschüre, Heftchen, Prospekt 

Patent Patent 

Personal Communication Persönliche Mitteilung 

Podcast Audiobeitrag 

Press Releases Presseerklärung 

Report Bericht, Rapport, Rechenschaftsbericht, Referat 
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Serial Serie, Reihe 

Speech Rede 

Standard Normen 

Statute Statuten, Gesetzesvorschriften 

Thesis Dissertation, Hochschulschrift 

Unpublished Work Unveröffentlichtes Werk 

Web Page Webseite 

 




